Appendix A

Using a Spreadsheet:
Microsoft Excel

On the surface, an electronic spreadsheet looks like nothing more than a table with numerous
rows and columns. But the typical features of spreadsheet software enable you to do many things
with the data you put in the table. For example, you can recode your data, reorganize it in various
ways, and perform simple calculations on subsets of data that you designate.

Here we look at one widely used spreadsheet, Microsoft Excel. We should point out that
Excel’s format may differ slightly depending on whether it is used with Microsoft Windows or a
Macintosh operating system. Also, each new update of Excel tends to be slightly different from
its predecessor in appearance and function. We are basing this discussion on the 2008 version of
Excel for Macintosh computers.

Using Excel to Keep Track of Literature Resources
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In any literature review, you are likely to draw on a variety of resources, probably including
books, journal articles, and Internet websites. You need to keep track of and report different in-
formation about each kind of resource. For a book, you need to know the author(s) or editor(s),
title, publication date, publisher, and the publisher’s location; in order to find the book in the
library stacks, you also need its call number. For a journal article, you need to know the author(s),
titles of both the article and the journal, publication date, volume number (and perhaps issue
number), and page numbers. The information you need for an Internet website is apt to vary
depending on the nature of its content, but at a minimum you need to record the Internet address
(uniform resource locator, or URL) and date on which you retrieved the document; or, for very
recently posted documents, the document's digital object identifier (DOI).

Let’s organize such information with Excel by going to the “File” menu and creating a
“New Workbook.” An empty two-dimensional table appears on the screen, with tabs labeled
“Sheet 1” and “+” at the very bottom. We'll use Sheet 1 to keep track of books. By clicking
on the top left-hand cell in the table, we can insert the word “BOOKS" in uppercase letters.
Then, by hitting the down arrow key on the keyboard, we move to the cell just below, where
we insert the words “Authors/Editors” (never mind for now that the words may appear to spill
over into the second column—appearances to the contrary, all words typed in any single cell
remain in that cell). Then, we hit the right arrow key on the keyboard, move to the cell to the
right, and insert the word “Title.” We continue moving to the right four more times, inserting
the words and phrases “Date,” “Call Number,” “Publisher,” and “Pub. Loc.” (short for “Pub-
lisher’s Location”). The words and phrases we have just entered in Row 2 will be our headings
for the columns.

At this point some of our headings are too long for the cells, so let's do two things. First,
let’s go to the “File” menu and then to “Page Setup” and click on “Landscape” and “OK.” By
doing this, we turn the page sideways and give ourselves more room across the page. Second,
let’s now move the cursor to the very top of the screen, where we see alphabet letters labeling
the columns. If we move the cursor to the line separating the A and B columns, a cross-with-
arrow-points icon appears. By clicking on the mouse at this point, we can drag the line to the
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right to make the “Authors/Editors” column wider. We can do the same thing for the other
columns as well, in each case adjusting column width to accommodate the column heading or
kind of information we expect to insert in the column cells. To make our headings more visible,
we'll also put them in boldface by going to the “Format” menu, then “Cells,” and then “Font”
and clicking on “Bold” and “OK.” With such steps we've set up our list for keeping track of
books.

Let’s now click on the “+” tab at the very bottom of the page. Doing so gives us “Sheet 2,” where
we can follow a similar procedure for journal articles. Again let’s set up the page in landscape mode. In
Row 1 we can insert “ARTICLES” and then in the first six cells of Row 2 we can insert che headings
“Authors,” “Article Title,” “Journal Title,” “Date,” “Vol/Iss” (for “volume and issue”), and “Pp.” (for
“page numbers”). As we did on Sheet 1, we can adjust the column widths and boldface our headings.
If we create a Sheet 3 for Internet websites, we need columns labeled “Address” and “Date Retrieved,”
plus possibly additional columns in which to insert names of authors or organizations, titles, posting
dates, DOIs (if available), and other pertinent informarion.

Our workbook of three spreadsheets is now ready for us to enter information about our
various library and Internet resources. We can print out the sheets and add the necessary informa-
tion in pen or pencil or, better still, we can take a laptop or tablet computer with us to the library
and insert the information directly into a computer document. Figure A.1 shows how the three
spreadsheets might look for a few resources on the topic of schizophrenia. Notice that some of

BOOKS

Authors/Editors Title Date |Call Number Publisher |Pub. Loc.

Noll, R. Encyclopedia of Schizophrenia and Other Psychotic Di 2007 |RC514 .N63 2007| Facts on File | New York

Walker, E. F. (Ed.) Schizophrenia: A Life-Course Developmental Persped 1991 [RC514 .53342 19| Academic Preg San Diego

Frith, C., & Johnston| schizophrenia: A Very Short Introduction 2003 |RC514 .F755 200 Oxford U. Pre Oxford, Er

e

ARTICLES

Authors Article Title Journal Title Date | Vol/Iss Pp.

Lublin, H.,& Eberhard, J.| Content versus delivery: Challenges | European Neuropsychopharm| 2008 | 18(Suppl 3) | v-vi

Tabarés-Seisdedos,R. Neurocognitive and clinical predictors| Journal of Affective Disorders| 2008 | 109(3) 286-299

Schwab, S. G., & Wilden| Research on causes for schizophrenia| Schizophrenia Research 2008 [ 102(1-3) 29-30
BT e ]

WEBSITES

Address Date Ret'd | Author/Org. Title Date Posted | Other Info.

www.nimh.nih.gov/health/to 9/15/08 | NIMH/ Schizophrenia 4/2/08

www.nim.nih.gov/medlinepluy]  9/17/08 | NIM/NIH Schizophrenia no date

www.schizophrenia.com/diac 9/18/08 | NARSAD Schizophrenia sympt| N0 date

" e tiigenn - e
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the entries (e.g., some book titles) are too long for the column width. No matter, because the
entries are recorded in their entirety in the spreadsheet document, and clicking on their particular
cells will bring them into full view. Notice, too, that the entries in the “Address” column for the
WEBSITES spreadsheet are in blue. When you type an Internet address into a cell, Excel auto-
matically makes it a hyper/ink: If your computer is currently online and you click on the cell, your
computer will take you to that website.

Once you have entered various library and Internet resources into your spreadsheets, you can
organize them in various ways, perhaps by call number (for books), journal title (for articles), or
date retrieved (for websites). We will look at how to organize spreadsheet entries in an upcoming
section. Although our focus at that point will be on organizing data, the same general organiza-
tional scrategies apply to any kind of information.

Using Excel to Record and Recode Data

As you have seen in the preceding section, the data you enter in the cells of an electronic spread-
sheet can take a variety of forms: text, numbers, dates, and so on. Thus you can use a spreadsheet
to keep track of the information you collect from a qualitative study (provided that the rext en-
tries are relatively short), a quantitative study, or a mixed-methods design.

For illustrative purposes, we'll use hypothetical data from a descriptive quantirative scudy.
We return to the four rating-scale items for risk taking presented in Chaprer 8:

Not at Somewhat Very

All True True True

11. 1would prefer to teach in a way that is familiar fo me rather

than trying a feaching strategy that | would have fo learn

how fo do. 1 2 3 4 5
16. |like trying new approaches to teaching. even if | occa-

sionally find they don’t work very well. 1 2 3 4 5
39. | would choose to teach something | knew | could do,

rather than a topic | haven't taught before. 1 2 3 4 5
51. | sometimes change my plan in the middle of a lesson if

| see an opportunity to practice teaching skills | haven't yet

mastered. 1 2 3 4 5

As you may recall from our discussion in that chapter, the researchers included chese items in
a longer list of items designed to assess a variety of traits in college education majors who were
completing their teaching internship year (Middleton, Ormrod, & Abrams, 2007). Let’s con-
sider how we mighr create a spreadsheet to enter the data for participants’ responses to the
entire survey. The general convention is to assign each row in the spreadsheet to a particular
participant and to assign each co/umn to a particular variable that we have assessed for each
participant. In this research project Middleton and his colleagues included several demo-
graphic variables (e.g., age, gender), supervisor ratings of teacher effectiveness, and partici-
pants’ responses to 69 rating-scale items designed to measure several personality and
motivational characteristics. For simplicity’s sake, we'll limit ourselves to the 4 rating-scale
items just presented plus 4 additional rating-scale items designed to measure perfectionism,
as follows:
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Not at Somewhat Very
All True True True
19. Itis very important that | always appear to be “on top
of things.” 1 2 3 4 5
27. It does not bother me if | occasionally make mistakes
in the classroom. 1 2 3 4 5
38. |do not want people to see me teaching unless
| am very good af it. 1 2 3 4 )
60. | always try o present a picture of perfection
in my feaching. 1 2 3 4 )

We'll create a spreadsheet for a sample of 10 hypothetical respondents to the questionnaire and
their responses to the 4 risk-raking and 4 perfectionism items (see Figure A.2). Note thar the
labels “RISK-TAKING” and “PERFECTIONISM” are only in cells B1 and F1, respectively, but
because cells to their immediate right are blank, we see the content of these cells in their entirety.

Can we add up the responses to the four risk-taking items to create an overall risk-taking
score and, similarly, add up responses to the four perfectionism items to create an overall perfec-
tionism score? No, not yet. If you look at the wordings for the eight items, you should notice
that the self-descriptions in Items 16 and 51 are indicative of high risk taking but the self-
descriptions in Items 11 and 39 are indicative of /ow risk taking. Similarly, Items 19, 38, and 60
reflect a desire for perfection, but Item 27 reflects comfort with smperfection. In order to have
responses to all items for a particular characteristic reflect a high degree of that characteristic, we
need to reverse, or recode, people’s responses to Items 11, 39, and 27, changing 1s into Ss, 2s into
4s, 4s into 2s, and 5s into ls, but leaving 3s as they are (e.g., in their recoded form, higher-
number responses to Item 11 indicate high rather cthan low risk taking). The following simple
formula makes this conversion for us:

6 - Original response = Recoded response
For example, if we want to recode a response of 5, then
6-5=1
Similarly, if we want to recode a response of 2, then

6-2=4

[S]
B [RISK-TAKING PERFECTIONISM
2 Person ##11|#16[#39[#51|#19[#27/#38][#60
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In Column J of our spreadsheet, we will make a new column, which we’ll label “Rev11” (for
“Reverse of Response to #11”). We're going to use a formula to create the values in this column.
In particular, let’s click on the first cell below our “Rev11” column heading (this is the cell for
Person #1). We type an equals sign (=), followed by a 6 and a minus sign. Before doing anything
else, we move the cursor to the cell containing Person #1’s response to Item #11 (where we see a
response of “2” for the item) and click on that cell. What we see in the Revl1 cell for Person #1
is the following:

=6-B3

We immediately press the Enter or Return button on the keyboard—we must press this button
before we do anything else—and Excel executes the formula to give us the desired value of 4.
Now here’s the cool part: We can click on the cell in which we've just entered a formula, “copy”
its contents, and then “paste” the contents into the nine cells immediately below in the same
column. What appears in each cell is the result of the same calculation using the appropriate value
for each person in onr sample. For example, Person #2’s response of “4” has been recoded as “2,” and
Person #3’s response of “5” has been recoded as “1.”

Ttems 39 and 27 need to be recoded as well. Let's label Columns K and L “Rev39” and
“Rev27” (for Items 39 and 27, respectively) and use the same procedure we used in the “Revl1”
column. This time, however, after typing “=6-"in the cell below the new column heading, we
click on the cell immediately below the heading “#39” or “#27,” depending on which item re-
sponses we're recoding. The spreadsheet with the three new columns is shown in Figure A.3

We are now ready to compute overall scores for our risk-taking and perfectionism items. Let’s
create yet another column in the spreadsheet and label it “ReScore” (for “Risk-Taking Score”).
We can again use the formula tool, this time adding together each person’s responses in the #16,
#51, Revll, and Rev39 columns. We take the following steps:

Click on Person #1's cell in the new column.
Hit the equals sign key (=) on the keyboard.
Click on the first cell below the “#16” label.
Hit the plus sign key (+) on the keyboard.
Click on the first cell below the “#51” label.
Hit che plus sign key (+) on the keyboard.
Click on the first cell below the “Rev11” label.
Hit the plus sign key (+) on the keyboard.
Click on che first cell below the “Rev39” label.

00~ O\ W

0

At this point, the entry in the cell you're creating should look like this:

=C3+E3+J3+K3
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FIGURE A.4

Adding two columns with overall scores for risk fking and perfeciionis

Immediately hit the Enter or Return button and—woi/a/—the value 16 should appear. Now copy
the contents of this cell into the nine cells below it in the column, and you'll see totals ranging
from 6 to 18 for the risk-taking items.

We can follow essentially the same procedure to create a total (which we'll call “PerfScore”)
for the perfectionism items, this time using the values in the #19, #38, #60, and Rev27 columns.
The results of our calculations are shown in Figure A.4.

Reorganizing Data in Excel

An additional feature of virtually all spreadsheets is an ability to organize the data by one or more
variables. Our current spreadsheet for responses to risk-taking and perfectionism items is organ-
ized by person number. But perhaps, instead, we want to organize it by risk-taking score, with
the greatest risk takers listed first and the relatively nonrisk-taking people listed last. We first
need to use the cursor to highlight all of the data we want to reorganize—in this case the 10 rows
and 14 columns of numbers. We move the cursor to the third cell in the first column (for Person
#1), click on the mouse, and then drag the mouse down and to the right until the 140 cells with
numbers are all highlighted. We then move the cursor to the “Data” menu and select “Sort.”
A box appears in which we can sort by several variables in order of priority, but in this situation
we want to sort only by risk-taking score. We type “RtScore” in the first box and, because we
want to have the high risk takers appear at the top, we click “Descending” (for descending order).
When we click on the “OK"” button, the data rearrange themselves, with Persons #5 and #8 (with
risk-raking scores of 18) appearing first and Person #2 (with a risk-taking score of 6) appearing
last.

A word of caution, however. Be sure that you highlight #// of the data columns in your spread-
sheet before hitcing the “OK” burtton. If you highlight only some of them (or perhaps only one
or two), you will reorganize the data only in those columns, leaving the dara in other columns
untouched. The result will be a scrambled mess, with some numbers for, say, Person #8 moving
to a new row and others staying where they were originally.

The sort tool isn't limited to numerical data. For example, let’s return to the spreadsheets we
created for the books, journal articles, and websites in our literature review. We could easily sort
our books by call number or our journal articles alphabetically by journal title, thereby making
our search for them in the library stacks more efficient.
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Using Excel to Perform Simple Statistical Analyses

When we used formulas to recode some item responses and to compute overall scores for risk
taking and perfectionism, we were using the function feature of Excel. Many functions are avail-
able in Excel, including numerous preprogrammed startistical analyses. For example, let’s say that
we want to compute basic descriptive statistics for the risk-taking and perfectionism scores for
our hypothertical sample of 10 people. We begin by typing the labels “Mean,” “SD” (for “Stand-
ard Deviation™), and “Cort” (for “Correlation”) in Column A in the three cells immediately below
our dara set. (This step is not required to complete our mission, but it helps us keep track of
which statistics we're putting where.)

The procedure we follow next depends somewhat on the particular version of Excel we are
using. In Excel 2008 for Macintosh, we now click on the cell representing the intersection of the
“Mean” row and the “ReScore” column, then go to the “Insert” pull-down menu at the top of the
screen and click on “Function.” An equals sign (=) appears in the table cell we've selected and a
function box appears on the screen; this box includes many possible calculations we mighe per-
form. In che function box, we scroll down to “AVERAGE" (we may possibly have to scroll a long
way until we reach the category “Statistical”) and” doxble-click on AVERAGE. At this point we
need to tell Excel which numbers—which in this case Excel calls *arguments”—rto use in calculat-
ing the average (mean). The bottom portion of the function box presents two places where we
can indicate the range of numbers we want to use in calculating the mean; for the mean, we want
to use only che firsc of these two places. Excel may also “suggest” one or more table cells with a
colored box; if it doesn't, we can create a box by clicking on one of the cells in our spreadsheet.
Then, by clicking on various sides and/or corners of the box and dragging the box in appropriate
directions, we can capture the numbers to be averaged—and on/y those numbers

at which point
we again hit the Enter or Return button on the keyboard. In the example here, we capture the
10 RtScore values for our 10 people, and the mean risk-taking score (12) for our sample appears
in the designated cell. We follow a similar procedure for the “PerfScore” column to obrain a mean
Perfectionism score (12.7).

We do essentially the same thing to obtain a standard deviation for our two sets of scores,
this time clicking on the appropriate cells in the “SD” row of our spreadsheet and double-clicking
“STDEV” in the right-hand column in the function box. This procedure gives us standard
deviations of 4.9889 and 4.056545 for the Risk-Taking and Perfectionism scores, respectively.

Finally, let’s calculate a Pearson product-moment correlation coefficient between the Risk-
Taking and Perfectionism scores. This calculation requires a slightly different procedure. We
must first click on che cell where we want the  value to appear, so let's use the cell representing
the intersection of the “Corr” row and the “PerfScore” column. We choose the function feature as
we did for means and standard deviations, then double-click on “CORREL.” At this point a box
appears that asks for “Array1” and “Array2.” With the Arrayl subbox highlighted, we highlight
the 10 data cells in the “RtScore” column of the spreadsheet (we must be sure nor to highlight
the mean and standard deviation we've already calculated). We then move the cursor to the
Array?2 subbox, click on it and then highlight the 10 data cells in the “PerfScore” column of the
spreadsheet. What we will see in the two subboxes are the following:

M3:M12
N3:N12

We immediately hic the Enter or Return key, and a correlation coefficient of —0.91139 appears.
In our hypothetical data sec, then, risk taking and perfectionism are strongly and negatively cor-
related.

The statistics we've just calculated include more decimal places than we need and commu-
nicate a precision that really isn’t warranted from such a small sample size. We can limit the
number of decimal places to 2 by going to the “Format” menu, then to “Cells,” then to “Num-
ber,” and then, under “Category,” to “Number” again. Our final calculations are shown in
Figure A.5, along with the data as we previously reorganized them by risk-taking scores.
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Mean 12 12.7
sD 4.99 4.06
Corr -0.91

The data set as reorganized, with descriptive statistics calculated

You can find other simple statistical tests in Excel, including 7-tests and chi-square (x?) tests.
For more sophisticated analyses, however, you will need statistical software such as SPSS, de-
scribed in Appendix B.



Appendix B
Using SPSS

A complete explanation of how to use SPSS—short for Sratistical Package for the Social
Sciences—is well beyond the scope of a short appendix. However, a brief explanation of some of
the basics can get you started. The version of SPSS we describe is PASW Scatistics Student Ver-
sion 18.0 for Macintosh.!

Creating a Data Set
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Once you have loaded SPSS onto the hard drive of your computer (see the directions that come
with the program for details), open the program. On your screen you will see a two-dimensional
table that looks very much like a spreadsheet. Each row in the table designates a specific indi-
vidual (human participant, animal subject, artifact, etc.) in your data set. Each column designates
a specific variable in the data set. Once filled in, this table will provide the basis for your data
analyses.

As an example, we use data from a pilot study that Dinah Jackson conducted in preparation
for her dissertation study (1996; excerpts from her dissertation appear in Chapters 1 and 12). The
data include the following information for 15 students in a college psychology class; (a) their
gender; (b) their scores on three exams given during the semester; (c) the total of the three exam
scores; (d) the quantity of class notes (i.e., number of pages) they took during the semester; and
(e) the quality of their class notes. The lasc of these variables—quality of notes—is based on
content analyses of students’ notes; the numbers are proportions of notes that reflect an integra-
tion of two or more ideas rather than a single, isolated fact. In Jackson’s study, better-integrated
notes (reflected in higher numbers, such as .406 or .496) were theorized to facilitate better
learning—and thus to be of better quality—than relatively non-integrated notes (reflected in
lower numbers, such as .166 or .040). Jackson's pilot data are shown in Figure B.1

Notice that the seven columns in the table in Figure B.1 have shorc labels chat tell us what
each variable is. To insert such labels, we go down to the bottom of the screen, where there are
two “buttons” called “Data View” and “Variable View.” If we click on “Variable View,” we get
another table, which looks like Figure B.2. In this table, we have entered information about each
of the variables in the data set. Here the variables are the rows (racher than the columns, as they
are in the “Data” table), and the things we want to say about the variables are the columns. To
keep our discussion simple, we describe only some of these columns:

B Name: Indicates the label that will appear for the variable in the “Data View” table. This
label can include alphabet letters, numbers, and a few other meaningful symbols (e.g., “$™).

! At the instructor’s reques, this book can be packaged with the Student Version of SPSS at a discount; the CD for the software
provides versions for both Windows and Macintosh users. Please contact your local Pearson representative if you are an instruc-
tor who is interested in setting up such a package for your students.
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Type: Indicates the type of data the variable represents, perhaps a number (numeric data), a
letter string, a dollar amount, a date, or something else altogether.

Decimals: Indicates an upper limit on the number of digits that will appear to the right of
a decimal point.

Label: Indicates the labels the variables will have when we create a table or graph—perhaps
one to be included in a dissertation or research report.

Vieulues: Indicates labels that might be attached to particular values of a variable. For exam-
ple, one of our variables is gender, a nominal scale. If we click on this “values” cell in the
“Gender” row, a little button appears at the right side of the cell. We click on the button,
and a box appears that allows us to tell the computer that a value of 1 means “male” and a
value of 2 means “female.” In Figure B.3, we show this box midway through the process:
We've already told the software that a value of 1 means “Male,” and we're in the process of
telling it that 2 means “Female”; at this point, we click on “Add” and then on “OK” to say
that we have labeled all possible values of the Gender variable.



344

The “Value Labels” box for
the “Variable View” table
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.Value Labels B L R — L R e
Value: 75

| Label: {Female| |

(Cancel ) ( OK )

%

Measure: Indicates whether the variable reflects a nominal scale or an ordinal scale; the
category “ordinal scale” also encompasses interval and ratio scales (Chapters 4 and 11
describe the four kinds of scales). As you can see in Figure B.2, our sample data set con-
sists of one variable (Gender) on a nominal scale and six variables thart are on interval or
ratio scales—hence also on an ordinal scale, which in the Variables table is simply called
“scale.”

Computing Basic Descriptive Statistics

Now that we have our dara set, let's conduct some simple analyses. First, let's compute basic
descriptive statistics for six of the seven variables (computing a mean and standard deviation for
the “gender” variable would, of course, be meaningless). We move the cursor to the word “Ana-
lyze” at the top of the screen and click on the mouse. A pull-down menu appears, and we move
the mouse down until the term “Descriptive Statistics” is highlighted, at which point another
menu appears to its right. We click on “Descriptives” in the right-hand box. A new box appears
in front of our data set. This box contains two smaller boxes, with all seven of our variables
listed in the left box. To calculate descriptive statistics for the last six variables, we want to move
them into the right box. We do this by highlighting each one and then clicking the right-arrow
butron between the two boxes. After we've moved the six variables, we click on the “OK” button
(see Figure B.4). At this point, a table appears that lists the number of observations (N), mini-
mum and maximum values, mean, and standard deviation for each variable. The final row in the
table, “Valid N (listwise),” simply means that SPSS found all 15 numbers for each variable to be
appropriate ones; in other words, it didn’t omit any scores in doing the calculations.

Now let’s suppose that we want to see how overall exam performance (Exam Score Tortal),
quantity of notes (Quantity of Notes), and quality of notes (Quality of Notes) are intercorrelated.
To do this, we can calculate Pearson r correlation coefficients for each possible pairing of these
three variables. Once again, we go up to “Analyze” at che top of the screen and click on the mouse.
When the pull-down menu appears, we move the cursor down until the word “Correlate” is
highlighted, then move the cursor to the right to highlight “Bivariate,” and then click on the
mouse. Once again, the two-box box appears, and we must move the three variables we want to
analyze to the right box and then click on “OK.” We now have a table that gives us the intercor-
relations among these variables, which we can print out by going to the “File” pull-down menu
and then to “Print” (see Figure B.5). The first number in each cell of the table tells us the Pearson
r for a particular pair of variables (this number is 1 when a variable is correlated with itself), and
the third number tells us the number of people for whom the r has been calculated. The middle
number tells us the probability (#) that we would obtain an r that high if the two variables were
not correlated in the overall population from which the sample has been drawn.

The table in Figure B.5 marks with two asterisks (*¥) all rs that are significant at an o level
of .01. But we don't necessarily have to use that alpha level. Imagine, instead, that we decide to
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FIGURE B.4

Identifying variables for
which we want basic
descriptive statistics to be
calculated

Correlations among exam
score fotal, quantity of
notes, and quality of
notes

Using SPSS 345
Variable(s):
7

& Exam 2 Score [Exa...
& Exam 3 Score [Exa...
_. | ¢ Exam Score Total [...
(%] | quantity of Notes ...
& Quality of Notes [N... ‘

e

"] Save standardized values as variables

@ (e @060
Correlations
Exam Score Quantity of Quality of
Total Notes Notes
Exam Score Total Pearson Correlation 14 323 425
Sig. (2-tailed) 241 114
N 15 15 15
Quantity of Notes  Pearson Correlation .323 1 2T
Sig. (2-tailed) .241 .001
N 15 15 15
Quality of Notes Pearson Correlation .425 o7 1
Sig. (2-tailed) 114 .001
N 15 15 15

**_Correlation is significant at the 0.01 level (2 -tailed).

use a significance level (o) of 0.05 for all of our analyses. Any p value in the table that is smaller
than 0.05 indicates that the variables probably are correlated in the population from which our
sample has been drawn. For example, the correlations between Exam Score Total and the Quan-
tity and Quality of Notes are .323 and .425, respectively. Although these correlations are in
the low-to-moderate range, the p values associated with them (.241 and .114) tell us that we
might get correlations this high simply by chance when the two variables are actually unrelated
in the overall population. (With a much larger sample size, such correlations would be statisti-
cally significant. Our small sample size may be leading us to make Type I errors here.) Now
let’s look at the correlation between Quantity of Notes and Qualicy of Notes. This correlation
is .777, which has an associated probabilicy of 0.001. This r is statistically significant: Students
who take more notes also take better notes. We must be careful, however, that we don't con-
clude that there is a causal relationship here: Taking more notes does not necessarily cause a
student to take better ones, nor does taking becter ones cause a student to take more of them.
Correlational data alone never allows us to draw clear-cut conclusions about cause-and-effect
relationships.

Computing Inferential Statistics

In the preceding section we already ventured into inferential statistics a bit. When we looked at
the probabilities that our correlation coefficients occurred by chance for a set of possibly unrelated
variables, we were drawing inferences. But now let’s do so intentionally. Let’s see if there are any
gender differences in the test performance of males and females. To find out, we need to perform
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a 7-test between the two groups. Once again, we go up to “Analyze,” and this time we highlight
“Compare Means” and then “Independent Samples T Test.”> A box similar to that shown in
Figure B.4 appears, but this one has three boxes within it. We move our dependent variable
(Exam Score Total) into the “Test Variable(s)” box and our independent variable (Gender) into
the “Grouping Variable” box. Next, we click on the “Define Groups” button and tell the com-
puter that a value of “1” puts a person in Group 1 (the males) and a value of “2” puts a person in
Group 2 (the females). We click on the “Continue” button and then click on “OK.” We get tables
that provide descriptive statistics for the two groups, information about whether the variances of
the two groups are equivalent, and results of 7-tests. We can, of course, print out these tables (see
Figure B.6). The program has calculated two s, one based on the assumprtion of equal variances
and another based on the assumption of unequal variances. Given the unequal variances for cthe
two groups (the F value for Levene’s test has a probability of .013), we’ll look at the second ¢,
which is .055. This value indicates chat the two groups are probably not different in their overall
exam performance (the p value is .957). (You can find explanations for the other numbers in this
table in many statistics textbooks or through an Internet search.)

We have room for one final statistical analysis. Let’s say we want to know whether the stu-
dents performed differently on the three exams they took during the semester. To compare three
means for the same group of students, we would ideally want to conduct a repeated-measures
analysis of variance. Unfortunately, the version of SPSS we are using here performs only between-
subjects ANOVAs, so we will have to settle for three paired-samples 7-tests.

To conduct our f-tests, we go back up to “Analyze,” move the mouse down to highlight
“Compare Means,” and then move it to the right to highlight “Paired-Samples T Tests.” We
release the mouse. Once again, we see a two-box box, but in this one the second box includes
three columns labeled “Pair,” “Variable 1,” and “Variable 2.” When we click on Exam 1 in che
left box and then click on the arrow, and then subsequently do the same thing for Exam 2, we
get an Exam 1-Exam 2 pair in the right box. In a similar manner, we can form Exam1-Exam 3
and Exam 2—Exam 3 pairs. We now have three pairs of variables in the right-hand box. We click
on “OK" and print out the three tables that the analysis generates (Figure B.7). The first table
gives us descriptive statistics; we've seen most of these before, but the column for standard error

Group Statistics

Gender Std. Std. Error
N Mean Deviation Mean
Exam Score Total  Male 7 | 117.6429 16.38524 6.19304
Female 8 | 117.2500 9.76418 3.45216

Independent Samples Test

Levene's Test for Equality of
Variances t-test for Equality of Means
95% Confidence Interval of
the Difference
Sig. (2- Mean Std. Error
F Sig. t df talled) Difference Difference Lower Upper

Exam Score Total Equal v.;rian(es 8.335 .013 057 13 955 .39286 6.85139 -14.40868 15.19439

assume

Equal variances not .055 9.520 957 .39286 7.09022 -15.51373 16.29945

assumed

FIGURE B.6 ; ;
Computing tto determine if males and females have different total exam scores

%As noted in Table 11.5 in Chapter 11, a #-test can take either of two basic forms. An independent-samples t~test enables a com-
parision of means for two separate, independent groups. For instance, an independent-samples f-test enables a comparison of
males versus females, as in the example presented here. In contrast, a dependent-samples t-test—also known as a paired samples
t-test—enables a comparison of means for a single group of individuals or, instead, for two related groups. For example, a
researcher might obrain measures of two characteristics of a single group of students or, alternatively, might obrain measures
of one particular characteristic both for a group of fathers and for their firse-born sons.
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Paired Samples Statistics
Std. Std. Error
Mean N Deviation Mean

Pair 1 Exam 1 Score | 39.9667 15 4.15102 1.07179

Exam 2 Score | 39.4667 15 5.42388 1.40044
Pair 2 Exam 1 Score | 39.9667 15 4.15102 1.07179

Exam 3 Score | 38.0000 15 5.15128 1.33006
Pair 3 Exam 2 Score | 39.4667 15 5.42388 1.40044

Exam 3 Score | 38.0000 15 5.15128 1.33006

Paired Samples Correlations
N Correlation Sig.

Pair 1 Exam 1 Score & Exam 2 15 .388 .153

Score
Pair 2 Exam 1 Score & Exam 3 15 622 .013

Score
Pair 3  Exam 2 Score & Exam 3 15 814 .000

Score

Paired Samples Test
Paired Differences
95% Confidence Interval of
the Difference
Std. Std. Error Sig. (2-
Mean Deviation Mean Lower Upper t df tailed)

Pair 1 gggg 1 Score - Exam 2 .50000 5.40089 1.39450 -2.49091 3.49091 .359 14 725
Pair 2 E:grr: 1 Score - Exam 3 1.96667 4.14241 1.06956 -.32732 4.26065 1.839 14 087
Pair 3 Eécoarn: 2 Score - Exam 3 | 1.46667 3.23329 .83483 -.32387 3.25720 1.757 14 101

FRGIEREED g i o
Computing fs fo defermine if students performed differently on the three exams

of the mean is new. We also see Pearson rs for the three pairs. We are most interested in the ¢
values for three pairs of exam scores, which are shown in the seventh column in the bottom table.
None of these #s is statistically significant at our significance level of .05 (see the rightmost col-
umn), although the Exam 1-Exam 3 pair comes close, with a p value of .087.

We have merely scratched the surface of what SPSS can offer. We have ignored some of the
values in che statistical tables we've presented. And we haven’t even touched on SPSS's graphing
capabilities. We urge you to explore SPSS for yourself to discover the many analyses it can per-
form and the many graphical displays it can create.
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150, 259, 262
phenomenological studies, 100, 145-146,
148, 150, 259
Quantitative research. See a/so Descriptive
research; Experimental research; Mixed-
method designs
data analysis and, 97, 270-308
dara collection and, 97, 98-99
deciding on approach, 98-101
definition of, 95
distinguishing characteristics of, 96-97
process of, 97
proposal writing and, 125
putpose of, 96
qualitative research compared to, 95-98
research reports and, 97, 312, 314, 321
Quartiles, 287
Quasi-experimental designs, 231, 232,
237-241, 246-247
Quasi-experimental research, 100
Questionnaires
bias and, 218
checklists or rating scales, 192-193
guidelines for constructing, 196-200
Internet and, 202, 217
mixed-methods designs and, 263
return rates and, 191, 196, 201-205
survey research and, 191
QuickCalcs, 303
Quota sampling, 214
Quotations, 69-70

Ramirez, I. L., 221-224
Random numbers, table of, 208, 208n,
209, 210
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Random sampling, 210-211
Random selection
descriptive research and, 230
population parameters and, 294, 295
posttest-only control group design and, 236
pretest-posttest control group design and,
234
probability sampling and, 207-208
quasi-experimental designs and, 237
random numbers table and, 209, 210
Range
measures of variability and, 287
statistics and, 276
Rank order, 85-86
Rating scales, in descriptive research, 192-193,
194
Ratio data, 279-280, 284
Ratio scales, 86-87
Raw score, 281282, 288-290
Reactivity, 102, 153, 229
Real-life settings, 103, 139
Realm of the Data, 78, 79
Reasoning
inductive, 18-19, 20, 23, 97
pitfalls of, 22, 23
probabilistic, 17
verbal, 17
Recoding, as spreadsheet function, 274-275
Records, as research problem category, 75
Reference librarians, 52, 55, 58
Reference lists
citations in text and, 131, 318
creating computer database of, 65-66
format for, 310
licerature review and, 59-60
in research reports, 318-321
URLs and, 59
Reflexivity, 312
Regression, 301
Relativity, theory of, 6, 20
Reliability
correlation coefficients and, 293
determining, 91-92
enhancing, 92-93
internal consistency reliability, 91, 199,
199n
interrater reliability, 91, 185
of measurement, 89, 91-92, 299, 316
of questionnaires, 199
Reliability coefficients, 199n
Repeated-measures designs, 231, 236-237
Replication
data admissibility and, 79
external validity and, 103
meta-analyses and, 249-250
as research criteria, 76
research reports and, 312
Reports, research
case studies and, 142
computers and, 9

conclusion of, 315-316
content analysis and, 149
critiquing, 327-328
data interpretation in, 311, 314-315
data presentation in, 313-314
description of method, 312
drafts of, 14
ethnography and, 144-145
feedback on, 326
figures and tables in, 14, 313, 313n
general principles of writing, 324-325
grounded theory studies and, 148
historical research and, 178
hypotheses and, 312, 314, 315, 316
juried, 24
language use and, 12
nonjuried, 24
objectives of, 310, 311
organization of, 321-323
phenomenological study and, 146
planning, 311-316
preliminary pages, 317-318, 321
preparation of, 323-325
presentations of, 329-331
prose style for, 323-324
published reports as models, 311
qualitative research and, 97, 312, 314, 321
quantitative research and, 97, 312, 314, 321
reference lists in, 318-321
related literacure in, 312
research problems and, 312, 313, 316
results section, 297
revisions of, 326
styles for, 310, 311
writing guidelines, 13-15, 310
writing schedule for, 114, 325-326
Representative samples, 103, 294
Research
in academic disciplines, 24, 76
characteristics of, 2-7, 5n
checklist of evaluating, 64—65
delimiting, 43-44
fact transcription versus, 2
fact transportation versus, 2
formal research, 2
meanings of, 1
misconceptions about, 1-2
schedule for, 113-116
Research cycle, 6-7, 19, 64
Research design, 74-77. See also Qualitative
research designs; and other specific
designs
Researcher as instrument, 139, 159
Research hypotheses, 3—4, 7, 40, 296-297,
298, 299-300
Research methodology. See Methodology,
research
Research problems. Sez Problems, research
Research process, basic format of, 6-7, 74-75
Research projects
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checklist for evaluating, 4647
feasibility of, 32-33, 110-112, 131
finding, 27-29
general criteria for, 76-77
hypotheses in, 34
planning and, 4-5
Research proposals. See Proposals, research
Research reports. See Reports, research
Research tools
computers as, 8-9
development of, 259
fine-tuning research problem and, 47
human mind as, 11, 16-21
identifying, 24-25
language as, 11-12
libraries as, 8, 24, 52-60
measurement as, 9-10
research methodology contrasted with, 7-8
statistics as, 10-11, 270
Resolution of puzzling findings, and mixed-
method designs, 259
Respondent validation, 104
Response cards, for questionnaires, 203, 204
Response rates, 190, 201-205, 218
Return rates
academic integrity and, 316
questionnaires and, 191, 196, 201-205
Reversal time-series designs, 238-239, 241,
247
Reviewers’ critiques, responding to, 332
Revisions
mulciple drafts and, 14, 48, 70
proposal writing and, 128—132
research reports and, 326
Reyna, V. E, 153
Righe to privacy, 107-108, 151, 158, 250, 316
Rigor, as qualitative research evaluation
criterion, 162
Rigorous subjectivity, 144
The Road to Xanadu (Lowes), 178
Robinson, N. M., 291
Robust statistical procedures, 282
Rogelberg, S. G., 202, 204, 218
Rohrer, D., 250
Rosales-Ruiz, J., 251, 274, 275
Rules for argument, 178

Sackur, J., 153

Sales, B. D., 105

Sample location selection, in multistage

sampling, 215

Sample means, distribution of, 295, 296

Samples
bias in, 206, 207, 294, 316
definicion of, 206
descriptive research and, 206-219
qualitative research and, 152
representative, 103, 294
research proposals, 134-135

Sample selection, 217-218
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Sample size, identifying sufficient, 298-299,
298n
Sample statistics
notation for, 278
population parameters and, 294
Sampling
bias in, 216-219
identifying sufficient sample size, 215-216
inferential scatistics and, 277
nonprobability sampling, 214-215, 218
online studies and, 251
online surveys and, 206
probability sampling, 207-214
qualitative tesearch and, 152
in surveys of very large populations, 215
Sampling bias, 216-219
Sampling designs, 207-215
Saunders, M. G., 19
Scales of measurement
interval scales, 86, 279
nominal scales, 85, 87, 279
ordinal scales, 85-86, 87, 279
ratio scales, 86-87, 279-280
types of, 84-87, 279-280
Scanners, for data tabulation, 201
Scatter plots, 186, 292
Schallert, D. L., 146
Schedule
for research, 113-116
for writing, 114, 325-326
Schram, T. H., 147, 152, 158
Schuman, H., 154, 156
Schunk, D. H., 41
Schwab, R. S., 19
Schwarz, N., 153, 190
Schwarzchild, Karl, 20
Scientific method, 19-20
Scott, K. M., 292, 293
Scotc-Jones, D., 105, 105n
Search and replace features, in word
processors, 15
Search engines, 58
Searching, keeping records of online
searches, 62
Secondary data, 78, 170
Secondary sources, 170, 173
Segment selection, in multistage
sampling, 215
Selective coding, in grounded theory
scudies, 147
Self-questioning, 13, 18
Self-report data, 190
Semistructured interviews, 190
SEM (structural equation modeling), 187, 188,
231, 301, 305
Senders, V. L., 87
Setting of the problem, 39, 45
Settings, real-life, 103, 139
Shaklee, J. M., 193
Shanahan, T., 12

Shank, G. D., 154, 157
Sheehan, K., 202
Sherman, S. J., 197
Sieber, J. E., 105
Sigman, M., 153
Significance level, 297
Silverman, D., 19, 153, 154
Simple ex post factor designs, 242-243, 247
Simple linear sequence, 273
Simple random sampling, 210-211
Simple time-series designs, 238, 247, 274
Single-group data, multi-group data
versus, 278
Single-subject designs, 241
Skagert, K., 146 ’
Skewed distribution, 281
Skype, 191n
Slides, for presentations, 330, 330n
Smich, R. M., 164-168
Sobel, D., 30
Sociograms, 83-84, 85
Software. See also Microsoft Excel; SPSS
(Statistical Package for the Social
Sciences); Word processors
bibliographic sofcware, 318
brainstorming software, 38-39, 60
data analysis and, 274~276
freeware, 66, 114, 274, 319
project management software, 114
statistical software packages, 302-303
transcription software, 157-158
Solomon, R. I., 235
Solomon four-group designs, 235, 243, 246
Sorting, as spreadsheet function, 274
Sowell, E. R., 57, 58
Spearman’s rank order correlation (Spearman’s
rho), 86, 292
Speculation, 4
Spell checkers, 14, 15, 16, 130
Spread, and measures of variability, 287-288
Spreadsheets, 194, 274-276, 302-303,
338-339. See also Microsoft Excel
SPSS (Statistical Package for the Social
Sciences)
computing basic descriptive statistics in,
344-345
computing inferential statistics in, 345-347
creating data set in, 342-344
Srivastava, A. K., 84
Srivastava, S., 206
Stake, R., 141
Standard deviation
interval scales and, 86
measures of variability and, 288-290, 294
square of, 292
standard scores and, 288-290
statistics and, 276
Standard error of the mean, 295-296
Standardization, in measurement, 92
Standard scores, 289-290, 290n

Stanines, 290
Stanley, J. C., 104, 228-229, 232, 232n
Static group comparisons, 234, 242, 246
Statistical analyses, Microsoft Excel for, 340-341
Statistical hypotheses, 296-297, 298, 299-300
Statistically significant, 297
Statistical Package for the Social Sciences
(SPSS). See SPSS (Statistical Package for
the Social Sciences)
Statistical significance, 89, 300, 304
Statistical software packages, 302-303
Statistical techniques. See a/so Data analysis;
Descriptive statistics; Inferential
statistics
dara interpretation and, 303-304
in Microsoft Excel, 340-341
nature of data and, 278-282, 285, 291, 293
purpose of, 276-277
rationale for in research report, 313
for testing hypotheses, 300, 301
weaknesses in, 315
Statistics. See a/so Descriptive statistics;
Inferential statistics
choosing appropriate statistics, 276-282
confounding variables and, 231-232
definition of, 270, 278
function of, 277-278, 291
measurement scales and, 87
null hypotheses and, 40
as research tool, 10-11, 270
Steiner, E., 20
Stern, J. E., 332
Stevens, S. S., 84
Story line, in grounded theory studies, 147
Stratified populations, 211
Stratified random sampling, 211
Strauss, A., 146, 146n, 147
Strauss, A. C., 146n, 147, 148
Strengeh, correlation coefficients for two
variables, 291
Stricker, J. M., 241
Strong correlation, 291
Strong Vocational Interest Blank (SVIB),
60-61
Structural equation modeling (SEM), 187, 188,
231, 301, 305
Structured interviews, 190
Strunk, W, Jr., 332
Scudent’s # test, 301, 346n
A Study of History (Toynbee), 177-178
Style of prose, 323324
Subheadings
attention to research problem and, 312
formatting, 122-123
Subjects, participants versus, 236
Subproblems
characteristics of, 36-37
data interpretation and, 37, 80
dividing research problem into, 3, 36-39
hypotheses and, 39
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identifying, 37-39
literacure review and, 60-61, 67
mixed-methods designs and, 259
proposal writing and, 45
pseudo-subproblems zersus, 36
in research reports, 312, 313, 316
Substantial measurements, 81,191, 272
Summaries
in abstracts, 317
in conclusions, 14, 316
in lierature reviews, 70
SurveyMonkey, 205-206
Survey research, 100, 189-191
Survey Research Center of the University of
Michigan’s Institute of Social Research,
215, 216-217
Surveys
design of, 189-190
Internet and, 205-206
sampling in surveys of very large
populations, 215
SVIB (Strong Vocational Interest Blank),
60-61
Swearer, S. M., 291
Symbols
for ordinal scales, 85
for statistics, 278
word processors and, 124
Systematic sampling, 212-213

Table of contents, 318
Table of random numbers, 208, 208n, 209, 210
Table of specifications, 90
Tables
definition of, 313
questionnaires and, 200
in research reports, 14, 313, 313n
two-dimensional rables, 273
word processors and, 15, 124
Tau correlation, Kendall’s, 292
Taylor, A., 41
Technology. See also Computers; Internet;
Software
brainstorming software and, 38-39, 60
collaboration and, 21
computer databases facilitating dara
organization, 159-160
computerizing observations, 194
conducting experiments on the Interner,
250-251
creating computer database of related
literature, 65-66
data analysis and, 200-201, 274-276
database for related literature, 65-66
data collection and transcription, 157—-158
data collection for descriptive research and,
205-206
historical research and, 175
interviews and, 195
literacure resources and, 334-336

licerature review and, 55-59
obtaining sources with, 63
online databases and, 55-58, 174
online library catalogs and, 53
for questionnaire administration, 200-201
referencing sources obtained on Internet,
320
research process and, 8, 9
search engines and, 58-59
statistical software packages, 302-303
writing assistance, 310-311
Telephone interviews, 1 90-191, 191n
Template documents, 194
Terms, defining, 4344, 45, 312
Tesch, R., 145
Test-retest reliability, 91
Tew, M. D., 206
Theoretical sampling, 152
Theories, defined, 20
Theory-building process, 20-21
Theory development, 147
Theory of relativity, 6, 20
Thesaurus feature, in word processors,
15,130
Thick description
qualitative research and, 162, 314
validicy and, 104
Things, as research problem category, 75
Third person, 324
Thompson, B., 292
Thompson, K. R., 20
Thompson, P. M., 57
Thoughts and ideas
as research problem category, 75
writing as clarification of, 12
Thrailkill, N. J., 68, 69, 227, 231
Title of work, in reference lists, 319~320
Title page, 317
Toga, A. W., 57
Topics, ordering, 45
Toynbee, Arnold, 95, 177-178
Track changes feature, in word processors, 15
Trahan, R. G., 102, 192, 193, 252
Transcription software, 157-158
Trautwein, U., 291
Treatment groups, 229
Treatments, 226
Trial-and-error explorations, as spreadsheet
function, 276
Triangulation, 102, 142, 162, 259
Triola, M. F, 216
Triserial correlation, 292
Trope, Y., 197
True experimental designs, 232, 234—237, 246
Trustworthiness, 262
Truch
academic incegrity and, 316
data and, 77, 78, 79, 94, 170, 173
mixed-methods designs and, 259
objectivity and, 139
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Tufts University, 108

Two-dimensional tables, 273

Two-factor experimental design, 243244,
247

‘Two-phase projects, 260, 263

Type I error (alpha error), 298-299, 299n, 314

Type II error (beta error), 298-299, 315

Underlining, italics versus, 46

Understanding Quantitative History (Haskins and
Jeftrey), 173

Uniform Resource Locators (URLs), 59, 320,
334

Universality, as research criterion, 76

Universe (population), 278

University of New Hampshire, 108

Unobtrusive measures, 102, 106

URLSs (Uniform Resource Locators), 59, 320,
334

Usefulness, as qualitative research evaluation
criterion, 162

U.S. Government Printing Office, 59

U-shaped relationships, 292, 293

Uziel, L., 153

Validity
considerations of, 101-104
correlation coefficients and, 293
determining, 90-91
enhancing, 92-93
external validity, 103-105, 207, 229, 235,
262
internal validicy, 101-102, 103, 189,
227-228, 232, 234, 262
of measurement, 44n, 89-91, 299, 316
mixed-methods designs and, 262
qualitative research and, 104
of questionnaires, 199200
Values
population parameters and, 278
research reports and, 312
vatiables and, 279
Vanderwood, M., 291
Variability. See a/so Measures of variability
population parameters and, 294, 296
qualitative research and, 152
Variables
confounding variables, 228, 316
continuous versus discrete variables, 279
correlational research and, 185-187
definition of, 40, 279
dependent variables, 4042, 226-227, 232
developmental design and, 188
experimental design and, 226-232
factorial design and, 243-244
identifying, 4042
independent variables, 4042, 226-227,
232, 243-245
latent variables, 82n
manifest variables, 82n
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measures of association and, 291-293
mediating variables, 41-42, 188

Variance, 288, 291-292

Vazire, S., 206

Verbal reasoning, 17

Verification, as purpose of qualitative research,

140

Video conferencing, 157, 191n

Visuals, for presentations, 330

Voice recognition software, 157-158

Voluntary participation, 105-106

Vul, E,, 250

Vygotsky, Lev, 12

Wagner, E. D., 244, 261

Walton, D. N., 20

Wasserman, S., 84

Weak correlation, 291

Web of Science, 57-58

Web pages, 21, 59, 320, 334, 335, 336
Wells, J. E., 292

Wennick, A., 148

“What ifs,” as spreadsheet function, 276

White, E. B., 332
Wikipedia, 59
Wilcoxon signed-rank test, 301
Williams, J. E., 206
Within-subjects designs, 231, 236-237, 246
Within-subjects variable, 231
Wirt, E., 218
Wixeed, J. T., 250
Wolach, A., 298n
Wolcote, H. F,, 139, 144, 145, 314
Wong, P. T. P, 133
Wood, H., 144
Word processors
copy and paste function, 174
footnotes created in, 324
guidelines for using, 15-16
importing data and, 274
for proposal writing, 124
prose style and, 323-324
questionnaires and, 201
saving documents, 15-16
search function, 175
tables and figures created in, 15, 124,
313,324

templates and, 194
Working memory, 11n
WorldCat, 58
World Wide Web (WWW). See Internet
Writing. See also Editing; Proposal writing;
Reports, research
assistance with, 310-311
communicating effectively through, 13-16
general principles of, 324-325
guidelines for, 13-15, 310
importance of, 12, 132
literature reviews, 67—70
multiple drafts and, 14, 48,70
qualirative research and, 100
schedule for, 114, 325-326
styles for, 310, 311

x? (chi-square) goodness-of-fit test, 301

Zambo, D., 14, 154, 155-156, 322-323
Zeith, T. Z., 291

Zero point, absolute, 87, 279
Zoomerang, 205-206

z-score, 289-290



